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SUMMARY
The book is an update of my PRINCE2™ Planning and Control Using Microsoft® Project
book and has been written so it may be used as:

» A training manual for a two-day training course,

> A self teach book, or

» A reference manual.

The screen shots for the book are taken from Microsoft Project Standard 2007 but the book
may be used to learn Microsoft Project Professional 2007 and all versions of Microsoft
Project 2003, 2002 and 2000 as the differences between the versions is described in this
book

The book has been written to be used as the basis for a two-day training course and includes
exercises for the students to complete at the end of each chapter. Unlike many training
course publications this book may be used by the students as a reference book after the
course.

This publication is ideal for people who would like to quickly gain an understanding of how
the software operates and explains how the software differs from Primavera P3 and
SureTrak, thus making it ideal for people who wish to convert from these products.

SPELLING

This book is written in US English to be compatible with the software menu. PRINCE2
terms have been spelt in British English spelling so not to contradict the British spelling of
PRINCE?2 terms.

AUTHOR’S COMMENT

As a professional project planner and scheduler and an Approved PRINCE2 Trainer I have
used a number of planning and scheduling software packages for the management of a
range of project types and sizes. There appeared to be very little literature aimed at the
professional who understands how to run projects, however require a practical guide on how
to use Microsoft Project in a PRINCE2 project environment. The first books I published
were user guides/training manuals for Primavera SureTrak and P3 users. These were well
received by professional project managers and schedulers, so I decided to turn my attention
to Microsoft Project 2000, 2002 and 2003. To produce this book I edited my Microsoft
Project 2003 book to explain how Microsoft Project may be used with PRINCE?2. I trust this
book will assist you in understanding how to use Microsoft Project on your PRINCE2
projects. Please contact me if you have any comments on this book.

I would like thank my daughter Samantha Harris and Peter Whitelaw of Rational
Management Pty Ltd, Victoria, Australia for their assistance in the production of this
publication.

COVER PHOTOGRAPHS

Top right Photograph of the Endeavour Replica in Melbourne Docklands, Australia.

Middle right  Iron bridge at Lower Landing on the West Coast Wilderness Railway
Tasmania, Australia.

Bottom right  ConocoPhillips Ltd, Humber Refinery, UK.
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1 INTRODUCTION

1.1 Purpose

The purpose of this book is to provide you with methods of using Microsoft Project and the
PRINCE2 Planning and Controlling components in a single project environment. The
PRINCE2 Product Based Planning Technique is not simply transposed to Microsoft Project;
this book makes some suggestions on how to best handle these areas of incompatibility.

The screen shots in this book were captured using Microsoft Project Standard 2007 and
Windows XP. Readers using Microsoft Project Professional 2007 will have additional menu
options to those shown in this book, which will operate when their software is connected to
Microsoft Project Server software. Users of Microsoft Project 2003, 2002 and 2000 will
find some minor differences in how the software functions which are outlined in Chapter
23 WHAT IS NEW IN MICROSOFT PROJECT and in the relevant sections of this
book.

By the end of this book, you should be able to:
e Understand the steps required to create a project plan using PRINCE2

e Set up the software

e Define calendars

e Add tasks which will represent the PRINCE2 Products and/or Activities
e Organize tasks and format the display

e Add logic and constraints

e Use Tables, Views and Filters to present PRINCE2 Project Plans, Stage Plans,
Exception Plans and Team Work Package Plans

e Print reports

e Record and track progress, producing PRINCE2 Highlight Reports and Checkpoint
Reports

e (Customize the project options

e (reate and assign resources

e Understand the impact of task types and effort driven tasks

e Analyze resource requirements and resource level a schedule

e Status projects that contain resources, producing resourced Highlight Reports and
Checkpoint Reports

e Understand the different techniques for scheduling

The book does not cover every aspect of Microsoft Project, but it does cover the main
features required to create and status a project schedule. It should provide you with a solid
grounding, which will enable you to go on and learn the other features of the software by
experimenting, using the Help files and reviewing other literature.
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This book has been written to minimize superfluous text, allowing the user to locate and
understand the information contained in the book as quickly as possible. It does NOT cover
functions of little value to common project scheduling requirements. If at any time you are
unable to understand a topic in this book, it is suggested that you use the Microsoft Project
Help menu to gain a further understanding of the subject.

1.2 Required Background Knowledge

This book does not teach you how to use computers or to manage projects. The book is
intended to teach you how to plan and control a project using Microsoft Project in a
PRINCE2 project environment. Therefore, to be able to follow this book you should have
the following background knowledge:

e An understanding of the PRINCE2 Project Management Methodology.

e The ability to use a personal computer and understand the fundamentals of the operating
system.

e Experience using application software such as Microsoft Office, which would have
given you exposure to Windows menu systems and typical Windows functions such as
copy and paste.

1.3 Purpose of Planning

The ultimate purpose of planning is to build a model that allows you to predict which tasks
and resources are critical to the timely completion of the project. Strategies may then be
implemented to ensure that these tasks and resources are managed properly, thus ensuring
that the project will be delivered within Tolerances, or more traditionally described as
delivered On Time and Within Budget.

A PRINCE2 Tolerance is the permissible deviation from plan without bringing the
deviation to the attention of the next higher authority. This may be negative or positive and
be defined in values such as costs, time, quality, scope and risks.

Planning aims to:
e Identify the Products and Activities required to deliver a project

e Evaluate different project delivery methods

e Identify and optimize the use of resources

e Optimize time and evaluate if target dates may be met

e Identify risks and set priorities

e Provide a baseline plan against which progress is measured

e Communicate the plan to all stakeholders, including what is to be done, when and by
whom

e Provide early warning of potential problems and enable proactive and not reactive
action to be taken

e Assist management to think ahead and make informed decisions

© Eastwood Harris Pty Ltd 1-2



PRINCE2™ PLANNING AND CONTROL USING MICROSOFT® PROJECT

Planning helps to avoid:

e Increased project costs or reduction in scope and/or quality
e Additional changeover and/or operation costs

e Extension of time claims

e Loss of your client’s revenue

e Contractual disputes and associated resolution costs

e The loss of reputation of those involved in a project

e Loss of a facility or asset in the event of a total project failure

1.4 Definition of a Plan

PRINCE?2 defines a plan as a document identifying all the Products to be delivered by a
project and their associated timescale, cost, quality and targets for the production of each.

A PRINCE2 Project Plan must at all times be able to deliver the expected benefits identified
in the Business Case.

PRINCE?2 also states that all plans must have the approval and commitment of all the
appropriate management levels.

A plan is therefore not just a Microsoft Project Gantt Chart (bar chart), although a Gantt
Chart is an important output of the planning process.

Microsoft Project is also able to record resource hours, costs and targets, and other basic
information that can be kept in the Notes or Custom (user defined) Fields. It is neither a
quality assurance nor a document management software package. Specialist packages
should be considered for those processes.

1.5 Elements of a Plan
PRINCE?2 defines the elements of a plan as:

e Products to be produced, both Specialist and Management

e Activities required to produce the Products

e Activities to validate the Products’ quality

e Resources required to produce the Products, including management and quality
e The relationships or dependencies between the Products and Activities

e External dependencies that will influence Product creation

e Timings for the Products

e Control points to measure progress

e Tolerances in time, cost and any other agreed variable

All these elements may be entered into Microsoft Project, as well as additional information
such as Notes and links to documents.
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A Plan must be supported with a document that explains:
e The scope of the Plan

e The method to be used to execute the project
e Methods to measuring progress and report
e (Quality control techniques

e Assumptions and risks

Products
B Quality
Frerequisites Requirements
Assumptions
Activities

v

Fesources

v

Risks | Control Points

v

Revised
Activities and
Resources

v

Time & Cost

Note the above picture was created using Microsoft Project 2007.
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1.6 Plan Levels

PRINCE2 defines four levels and five types
of plans: Plan

Programme

v

Project Plan

v

Stage Plan . Exception

Plan
v

Tearm Plan

Programme Plan, a Project Plan may be a stand-alone plan or part of a portfolio of
multiple projects within a programme.

Project Plan, this is mandatory and updated throughout the duration of a project.

Stage Plan, there are a minimum of two Stage Plans: an Initiation Stage Plan and
First Stage Plan. (There would be usually one Stage Plan for each Stage.)

Exception Plan, which is at the same level and detail as a Stage Plan and replaces a
Stage Plan at the request of a Project Board when a Stage is forecast to exceed
Tolerances.

Team Plan is optional and would be used on larger projects where Teams are used for
delivering Products which require detailed planning. A typical example is a contractor’s
plan that would be submitted during the bidding process.

1.6.1 Programme Plan

A Programme Plan contains a large amount of information including:

The Vision Statement, a statement of the target or targets of an organisation and the
performance measurements of the new capabilities.

The Blueprint, the outline of practices, processes, information and technology required
to deliver the Vision Statement.

Benefits, a statement of the benefits that the programme will deliver the Organisation.
Benefits may be scheduled and monitored using Microsoft Project with tasks in a
programme level.

Projects, which may be grouped under Tranches.

Resources, which outlines the people, equipment, funding and all other assets required
to deliver the Projects. This allows the management of resources amongst projects; it is
possible to share a Microsoft Project Resource pool over more than one project.

Stakeholders, identification and communication with the stakeholders to ensure that the
right products are delivered; their acceptance is very important.

Risks, managed at both Programme and Project level. A sound Risk Management Plan
and supporting processes are required to successfully manage a Programme.
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Timetable, this outlines deadlines and the timeline that the programme must work to.
This timeline would usually impose start and completion dates for projects. The
programme work may be scheduled with Microsoft Project and include tasks for
Benefits Realisation.

Progress monitoring, established in a programme. Programmes may be divided into
Tranches, which are distinct steps of a Programme, they may be tied to a financial
instalment and provide a point where the business benefits of completed projects may be
evaluated.

Transition addresses the cultural changes required in an organisation from the Project
Approach through to the smooth operation of a new process.

Programme planning steps are as follows:

The Portfolio of projects should be designed.

The Projects and the Programme Benefits Realisation are scheduled and the Benefits
Realisation should be aligned with the programme strategic objectives.

The Project plans should show an increasing level of detail as they are executed and
progress is reflected back into the Programme Plan.

The Programme schedule will have to be monitored, reviewed and revised as the
projects progress and the effects of external events and emerging risks impact on the
Programme.

Below is a very simple example of a programme plan produced with Microsoft Project to
demonstrate how Microsoft Project may be used to assist in the management of
Programmes:

Task Mame 10 11 12 13
Citr 1| Qtr 2 [ Cr 3| Qb 4 | Qtr 1 [ Gir 2| Ofr 3| Otr 4 [ G 1 | Qb 2 |Qtr 3| Otr 4 | Citr 1 |Qtr 2 C-Jtr3|@tr4

= Prograrmrme P v

Strategies
Policies

Portfolio Establishment —
Tranche 1 Complete

Tranche 1 Benefits Realisation

Tranche 2 Complete n

Tranche 2 Benefits Realisation
=l Tranche 1

Project 1

Project 2 T
Project 3
=I Tranche 2 -
Project 4
Project 5

Project B
Project 7

Project & . .
Praject 8 5
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1.6.2 Project Plan

The Project Plan is the overall control document for the Project Board, who is responsible
for directing and monitoring the project in terms of Product, Cost, Timing, Resources and
Control Points. Quality is documented in the Project Quality Plan. The Project Plan is part
of the Project Initiation Document (PID) and the Project Plan is Baselined after the project
has been authorised in DP2 — Authorising a Project.

The Project Plan is updated at least:
e At the end of each Stage, and

e  When a Project has exceeded Tolerances and the Project Board has requested the
Exception Plan.

1.6.3  Stage Plan
There are a minimum of 2 Stages in a PRINCE2 project and each have a plan:
e Initiation Stage Plan, created during Starting Up a Project, and

e First Stage Plan, created during the Initiation Stage.

A Next Stage Plan is created towards the end of the previous Stage and approved by the
Project Board before the next Stage commences.

A Stage Plan provides the Project Manager with a tool for day-to-day management of the

project. It would have a greater level of detail than the Project Plan and would fit into the

timing of the Project Plan. A Stage Plan may be created in Microsoft Project in several

ways:

e (Granulating the Project schedule into more detail in the Projects schedule file , thus
creating a single schedule that contains both Project and Stage schedules, or

e (reating a stand-alone schedule for each Stage that is manually aligned to the Project
Plan. This allows the Project Manager to set tighter time Tolerances on a Stage schedule
than the Project schedule. Thus creating a Stage schedule with a tight Stage Tolerances
to force Team Managers to deliver the products on time, or

e Creating a stand-alone schedule for each Stage that is inserted into a Project Schedule.

1.6.4  Exception Plan

When a Stage exceeds Tolerances, normally identified as a breach of time or cost but could
include Scope, Quality, Risk or Benefit, then the project is in Exception. If a Stage breaks
Tolerances:

e The Project Manager may create an Exception Report in the sub-process CS8 —
Escalating Project Issues and would submit the Exception Report, which should
include options for the future course of the project, to the Project Board.

e The Project Board may request an Exception Plan from the Project Manager in DP4 —
Giving Ad Hoc Direction.

e The Project Manager would produce an Exception Plan in SB6 — Producing an
Exception Plan and submit it for approval by the Project Board,

e Should the Project Board approve the Exception Plan in DP3 — Authorising a Stage or
Exception Plan, this plan would replace the current failed Stage Plan.
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1.6.5 Team Plan

Team Plans are optional plans for detailing out the delivery of one or more products
included in a Work Package and would typically be represented by:

e A subcontractor plan for the delivery of a product which could be submitted with a bid
for work, or

e A plan supplied by another team, group or department for the internal delivery of
products.

A Team Plan should be approved as part of Accepting a Work Package and progress
would be reported in Checkpoint Reports from a Team Manager to the Project
Manager. In a similar way to the development of a Stage Plan from a Project plan, a Team
Plan may be integrated into a Stage Plan in several ways. For example:

e A single task may be manually inserted in the Stage schedule to represent all the tasks
from a Team schedule, and manually updated.

e A single task representing each of the Team schedule summary tasks may be manually
inserted into the Stage schedule and manually updated, thus providing a summary of the
Team schedule with more than one task.

e  When a Team schedule is received electronically it may have all its tasks copied and
pasted into the Stage plan as long as all the activities and resources are common.

e  When a Team schedule is received electronically it may be inserted into the Stage
schedule and look like a sub-project.

1.7 Controlling a Project
Controlling a project ensures:
e The work is being authorised in accordance with the plan

e The required products are being produced
e The required quality is being met

e The products are being produced on time, with the planned resources and to the planned
costs

e The project products will achieve the Business Case

Controlling a project provides the next level of management with information allowing
them to:

e Monitor the progress of products
e Compare the progress with the plan
e Review options

e Forecast problems as early as possible enabling corrective action to be taken as early as
possible

e Authorise further work
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1.7.1 Project Board Controls
The Project Board controls the project using the following processes:

DP1 — Authorising Initiation where an Initiation Stage Plan would be reviewed and
approved.

DP2 — Authorising a Project where the Project Plan and First Stage would be reviewed
and approved.

DP3 — Authorising a Stage Plan where:

» A Stage would be reviewed and approved, or

» After receiving an Exception Plan and holding an Exception Assessment meeting,
the Exception Plan would be reviewed and approved.

DP4 — Giving Ad Hoc Direction after reviewing:
» Highlight Reports from the Project Manager produced in CS6 — Reporting
Highlights which would include an update of the Stage Plan, or

» Review Exception Reports created by the Project Manager in CS8 — Escalating
Project Issues, which would show Tolerances being exceeded.

DPS5 — Confirming Project Closure where the Actual Duration and Costs would be
compared to the Planned Duration and Costs.

1.7.2  Project Manager Controls

The Project Manager controls the project through the normal day-to-day management
activities which should be recorded on the Daily Log. The Project Manager controls
Product delivery through:

The definition of Products in PL2 — Defining and Analysing Products,
Authorising work to commence in CS1 — Authorising Work Packages,

CS2 — Assessing Progress where the Project Manager would review Checkpoint
Reports created by Team Managers, and

CS9 — Receiving Completed Products.
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1.8 Project Planning Metrics

There are four components that are usually measured and controlled using planning and
scheduling software:

Time

Effort (resources)
Cost

Scope

Time

SCOPE

Resources Costs

A change in any one of these components normally results in a change in one or both of the
other two.

Other project management functions that are not traditionally managed with planning and
scheduling software but may have components reflected in the schedule include:

Document Management and Control,
Quality Management,

Contract Management,

Issue Management,

Risk Management,

Industrial Relations, and

Accounting.

The development of Enterprise Project Management systems has resulted in the inclusion of
more of these functions in project planning and scheduling software.
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1.9 Planning Cycle

The planning cycle is an integral part of managing a project. A software package such as
Microsoft Project makes this task much easier.

When the original plan is agreed to, either Project or Stage, the Baseline is set. The
Baseline is a record of the original plan. The Baseline dates may be recorded in Microsoft
Project in data fields titled Baseline Start and Baseline Finish.

After project planning has ended and project execution has begun, the actual progress is
monitored, recorded in CS2 — Assessing Progress and compared to the Baseline dates in
CSS — Reviewing Stage Status.

The progress is then reported in Checkpoint Reports produced by Team Managers for the
Project Manager or Highlight Reports produced by the Project Manager for the Board.

The plan may be amended by adding or deleting tasks and adjusting Remaining Durations
or Resources. A revised plan is then published as progress continues.

Plan
the Project

Execute
Work

Monitor
Progress

Revise Plan

Evaluate and
Report
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1.10 PRINCE? Planning Component and Microsoft Project
The picture below shows the PRINCE2 processes:

Directing a Project
DP1  Authorising DP2  Authorising a DP3  Authorisinga DP4  Giving ad hoc DP5  Confirming
Initiation Project Stage Plan or Direction Project Closure
Exception Plan
Startingup a Initiating a Controlling a Stage Managing Stage  Closing a Project
Project Project Boundaries
SU1 Appoainting a PB IP1 Planning Quality] |CS1  Authorising a CS2  Assessing CS3  Capturing SB1  Planninga CP1 De-
Executive and a| Work Package Progress Project Issues Stage commissioning @
PM project
SU2 Designinga PM IP2  Planninga CS4  Examining CS5 Reviewing CS6  Reporting SB2  Updatinga CP2  Identifying
Team Project Project Issues Stage Status Highlights Project Plan Follow on
Actions
SU3 AppointingaPM | IP3  Refining the Ccs7 Taking CS8  Escalating CS9  Receiving SB3  Updatinga CP3  Evaluatinga
Team Business Case Corrective Project Issues Completed Project project
and Risks Action Work Package Business Case
SU4  Preparinga IP4  Setting up SB4  Updating the
Project Brief Project Controls| Risk Log
SU5  Defininga IP5  Setting up SB5 Reporting Stage|
Project Project Files |  Managing Product Delivery End
Approach
SU6 Planning an IP6  Assemblinga MP1  Acceptinga MP2  Executinga MP3  Deliveringa SB6 Producing an
Initiation Stage PID Work Package Work Package Work Package Exception Plan
Planning
PL1  Designinga PL2  Defining and PL3  Identifying PL4  Estimating PL5  Scheduling PL6 AnalysingRisks| [PL7 Completinga
Plan Analysing Activities and Plan
Products Dependencies

It is possible to use Microsoft Project to support most PRINCE2 processes, as presented in

the table below:
SU2 | Designing a PM | There are some functions in Microsoft Project that allow
Team Organisation information to be recorded. This may be
achieved by using either a Resource Customized Field or a
Resource Customized Outline Code to record the
Organisation Structure and assign these codes to resources.
SU6 | Planning an The Initiation Stage plan may be prepared and presented in

Initiation Stage

Microsoft Project.

PL1 | Designing a Plan | Microsoft Project may be nominated as the planning tool in
this process. However it would not be used to define this
process, normally a word processor software package such as
Microsoft Word to create the Plan Design document.

PL2 | Defining and The PRINCE2 Product Based Planning technique is a good

Analysing technique and is used to define and analyze products.
Products Products may be represented as Tasks, or Summary Tasks

using the Outlining feature, or by using a Custom Outline

Code.
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Product Based
Planning

1. Defining the Product Breakdown Structure may not be
duplicated exactly in Microsoft Project due to formatting
limitations. Graphical flow charting tools or specialist
PRINCE2 tools may be used to duplicate this process
exactly. Only a close approximation of a Product
Breakdown Structure may be duplicated using Outlining
or a Custom Outline Code structure.

2. Product Descriptions may be recorded in Microsoft
Project using a number of methods including:

» Notes, as an attached file, or

» Custom Fields.

When data such as Product Descriptions are entered into
Notes or in User Defined Fields in Microsoft Project, this
information is no longer accessible to those who do not
have access to the software. This may deter the use of
Microsoft Project to record such data.

3. A PRINCE?2 type Product Flow Diagram may be created
in Microsoft Project by using the Network Diagramming
function; however, users may find this software function a
little time consuming to use for this purpose.

PL3

Identifying
Activities &
Dependencies

Microsoft Project will handle this process as it is the primary
purpose of the product.

PLA4

Estimating

Microsoft Project may be used for estimating and has a
number of functions that would assist including Labor
Resources, Material Resources, Cost Resources (new to
Microsoft Project 2007) and Fixed Costs. A user must be
aware that a detailed schedule with many resources and costs
is very difficult to update and maintain as the project
progresses. Consider the use of an external estimating system
or a spreadsheet with the summary costs then transferred to
Microsoft Project.

PL5

Scheduling

Microsoft Project is designed to handle this function.

PL6

Analysing Risks

Microsoft Project is not a Risk Analysis tool. It may be used
to evaluate options and include risk countermeasure activities;
however, it is recommended that Risk Analysis data be
recorded outside Microsoft Project.

PL7

Completing a
Plan

The output from Microsoft Project would form part of the
plan, but it should not be the only element in the plan.
Microsoft Project Views and Tables would be used to create
reports for stakeholders to review the schedule.

DP1

Authorising
Initiation

The Initiation Stage schedule would be created in Microsoft
Project and form part of the Initiation Stage Plan authorised in
this PRINCE2 sub-process.

DP2

Authorising a
Project

During this process a project schedule created in Microsoft
Project would be analyzed. Microsoft Project Views and
Tables would be used to create reports for the Project Board
to review.

DP3

Authorising a
Stage or
Exception Plan

The review of a Microsoft Project Stage schedule would form
part of this review.
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DP5 | Confirming The Project and Last Stage Plan should be reviewed to ensure
Project Closure | all activities are complete.
CS1 | Authorising and | The Timing and Costs aspects of a Work Package may be
and | Accepting a calculated and recorded in Microsoft Project. When there is
MP1 | Work Package more than one task per Work Package then tasks associated
with a Work Package may be tagged with a Custom Field and
all the WP tasks viewed with a filter when the WP tasks are
separated by other activities, or if the activities are in one
location they may be demoted under a summary task.
CS2 | Assessing These processes could be managed in Microsoft Project by
and | Progress and statusing the schedule in the normal way.
CSS5 | Reviewing Stage | Microsoft Project Filters would assist in isolating Stage
Status activities and the Baseline function would show deviation
from the Approved Stage Plan.
MP2 | Executing a Microsoft Project may be used to record and report the
Work Package progress of a Work Package.
CS6 | Reporting Microsoft Project Views, Tables and Filters may be used to
Highlight create elements of a Highlight Report.
MP3 | Delivering a A Microsoft Project Schedule would be updated when a Work
and | Work Package Package is completed and delivered.
and
CS9 | Receiving
Completed Work
Package
SB1 | Planning a Stage | Microsoft Project may be used in the way identified in PL1 to
PL7 above.
SB2 | Updating a The Project schedule would be updated as part of this process.
Project Plan Activities would be updated with progress and compared to
the Approved Project Plan.
SB5 | Reporting Stage | The Stage schedule would be updated as part of this process.
End
SB6 | Producing an The replacement Stage schedule and possibly the Project
Exception Plan schedule would be updated as part of this process.
CP3 | Evaluating a The Baseline schedule should be compared to the actuals and

Project

the performance evaluated from this comparison.
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4 NAVIGATING AROUND THE SCREEN

4.1 Identify the Parts of the Project Screen

After a blank project has been created from a template, the default Microsoft Project 2007
screen will look like this:

Menu bar Title bar Standard bar Format bar Timescale
B Microsoft Project - Project1 E\E|E|
i) fle Edt View Insert Format ool  Project Mindow  Help Type aquestion for help = 8 X
P EHT G AT BB 985 gE L] B | NoGfow vI@%'é&@"IE!@!
. i @ 4 = o show- | Anal <8 =B I 0|E]==]Amss | -ve]
Edit - > £
bOX o puren s Fls[s JAEGEKNIDFT [F[s]s rﬂ:eﬁlifo\qr [F[s]s :nwﬁrah F ?;\s Wfﬂffn [FIs]s :45|“Tna\r\l;tu|aT [ =
Select
All
button
View
bar

v

[« | L | K ;ﬁ
f HUM

' |
Status bar Scroll bars Split Screen
bar

Microsoft Project has a Windows-style menu system with a typical Windows look-and-feel.

e The project name is displayed after Microsoft Project at the top of the left-hand side of
the screen.

e The drop-down menus are just below the project name.
e The toolbars are displayed below the menu.

e The left-hand side of the line underneath the toolbars is the Entry Bar and Edit Box.
Any editable data may be edited in the Edit Box or directly in the field.

3w Project Kickaff

o Task Marne Duration Start Finish 24 Mov '08 1 Dec 08
FIS[SIM[T[W[T[F[S[5[M[T[W[T
1 | ProjectKickoff | 1day? 1 Dec 08 1 Dec =

The [ and (% icons are displayed on the left of the Edit Box only when performing
editing, and may be used for accepting and not accepting data changes that are made
from within the edit box.
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e The main display has the Bar Chart or Gantt Chart on the right-hand side, with the
Timescale above, and the Data Columns on the left-hand side with their column titles
above them. The divider between the two areas may be dragged from side to side by
holding down the left mouse button.

e The View Bar displays the same options as the View menu and is located on the far left
of the screen. This may be hidden or displayed by:

» Selecting View, View Bar, or
» Holding the mouse pointer over the View Bar, right-clicking to display a menu, and
selecting View Bar.

e The horizontal Scroll Bars are at the bottom of the screen and the Status Bar is below
the Scroll Bars. The vertical Scroll Bar is at the right-hand side of the screen.

It is recommended screens to hide the View Bar when using computers with
small as it consumes valuable screen space that is often better utilized
showing project data.

4.2  Customizing the Screen

The screen may be customized in a number of ways to suit your preferences. The toolbars
and menu bar may be moved around the screen by holding down the right mouse button and
dragging them to a new position on the screen.

4.2.1 Toolbars

Toolbars will not be covered in detail but significant productivity improvements may be
made by ensuring that functions frequently used are available on a toolbar.

e There are many built-in toolbars in Microsoft Project. These may be displayed or hidden
by:

» Using the command View, Toolbar or Tools, Customize, Toolbars... and selecting
the Toolbar tab, then checking or un-checking the required boxes to display or hide
the toolbars, or

» Right-clicking the mouse in the toolbar area to display a Toolbar menu.

e [cons may be added to a bar by selecting Tools, Customize, Toolbars..., Commands
tab. Toolbar Icons may be selected from the dialog box and dragged onto any toolbar.

e [cons may be removed from the toolbars after the Customize (Toolbar) form is opened
by holding down the left mouse button on the icon and dragging them off the toolbar.

e Icons may be reset to default by selecting Tools, Customize, Toolbars..., selecting the
Toolbar tab and clicking on “

e Other toolbar display options are found under Tools, Customize, Toolbars... and then
selecting the Options tab.
It is recommended to check the Always show full menus option in the
0 Tools, Customize, Toolbars..., Options tab to ensure full menus are always
displayed. This saves time waiting for the menu item you require to be
displayed.

4.2.2 Menu Bar

The Menu Bar display options are found under Tools, Customize, Toolbars... and then
selecting the Options tab.
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4.3  Setting up the Options

The basic parameters of the software must be configured so it will operate the way you
desire. In order for the software to operate and/or calculate the way you want, some of the
defaults must be turned on, or off, or changed. These configuration items may be found
under Tools, Options....

We will discuss some of the more important options now. All the Options are discussed in
the OPTIONS chapter. Select Tools, Options... to display the Options form.

Select the View tab:
Options g]
Interface ‘ Security
Schedule Calculation Speling Save
Wiew General Edit Calendar

Default wiew: Gantt Chart -
Calendar type: | Gregorian Calendar v
Date format: 28 Jan '02 -

Show
Stakus bar scrall bars OLE links indicatars
‘Windows in Taskbar Entry bar Project screentips
Bars and shapes in Gantt views in 3-0

Cross project linking options For “Workshop 1.mpp'
Show external successors Show links between projects dialog box on open
Show external predecessors

Currency options For “Waorkshop 1.mpp!’
Symbal: 4§ Decimal digits: |2 —
Placement: $1 | Currency: ALD bl

Cutline options Far “Warkshop 1.mpp'
Indent name Show outline symbal [Jshow project summary task
[ 5how outline number Show summary tasks

[ Ok ] [ Cancel ]

e Date format: This is used to select the display style of the dates for all projects. The
date format will be displayed according to a combination of your system default settings
and the Microsoft Project Options settings. You may adjust your date format under the
system Control Panel, Regional and Language Options and the Microsoft Project
settings in the Options form, which are covered in the OPTIONS chapter.

There is often confusion on international projects between the numerical US
0 date style, mmddyy and the numerical European date style, ddmmyy. For
example, in the United States 020710 is read as 07 Feb 10 and in many other
countries as 02 Jul 10. Consider always adopting the ddmmmyy style, 06
Jan 07 or mmmddyy style, Jan 06 ’07.
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e Select the Schedule tab:

Options E|

‘ General Edit l Calendar ]
Security

l Calculation Spelling l Save ]
Schedule options For Microsoft OFfice Project
Show scheduling messages
Show assignment units as a; | Decimal w
Scheduling options Far “Warkshop 1.mpp’
Mew tasks: Skart On Project Start Date
Duration is enkered in: Days

Wwork is entered in: Hours

LA EYE A

Default bask bype: Fixed Duration

[Imew tasks are effort driven

[] autalink inserted or moved tasks

Split in-progress tasks

[]1asks will always honor their constraint dates
Show that tasks hawve estimated durations

Mew basks have estimated durations Set as Default

[ Ok ][ Cancel l

e New tasks: - When the option of Start on Current Date is selected new tasks are
assigned an Early Start constraint as they are added to the schedule.

It is not desirable to have activities assigned constraints as they are created in
a Critical Path schedule, therefore Start On Project Start Date should always
be selected when creating a Critical Path schedule.

e Duration is entered in: — This option specifies the format in which durations are
entered via the keyboard. If Day is selected as the default, then a duration of 2 days is
entered as 2 (without the d). If Hours is selected as the default, then a 2-hour duration
should be entered as 2h.

e [t is important that both the Autolink inserted or moved tasks and the Tasks will
always honor their constraint dates are both unchecked.

» Autolink inserted or moved tasks option will result in relationships being changed
when tasks are dragged to another position.

» Tasks will always honor their constraint dates results in the possibility of tasks
being scheduled earlier than it is technically possible.
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4.4  Splitting the Screen Views and Details Forms

The screen may be split horizontally into two panes. A different View may be displayed in
each pane. This is termed Dual-Pane view. To open or close the dual-pane view:

e Select Window, Split or Window, Remove Split, or
e (Grab the horizontal dividing bar at the bottom of the screen (see the picture in paragraph
4.1) by holding down the left mouse button and dragging the line to resize the panes.
e Right-click in the right-hand side of the top pane and you will, in most views, be able to
display a menu to open or remove the split.
e Double-click the dividing line or drag it to also remove or open the split window.
@ Microsoft Project - OzBuild 04.mpp E@E\
lﬁ File Edit View Insert Format  Tools  Project  Report  Window  Help Type & qusstion for help [+ @ X
W % 4+ = Eg Show~ | Aral -8 + B 7 U = = = 4\ V= LevelNow Al Tasks
. ZE&2 7 B e s m B Neew - RQ LN TN N SEBEES
Active
pane has g e Pedon S s s T TP [s TS W T W T S S M T T
1 | Bid Request Documerts Recsived | odays 1 Dec 06 1 Dec '8 § 112 =
dark 2 Bid Strategy Tday  1Decs 1 Dec'd @
3 Technicel Feasiilty Study 8 days 1Dec0s  10Dec'0d | ——)
band L= Installation Recuirements 4 days 1 Dec 08 4 Dec'03 —]
5 Supplier Component Bids 3days 1 Dec 08 3Dec'08 e 4
8y Project Scheduls 4days 1 Dec 05 4 Dec'08 —
7 Technical Specification 9 days 1DecDE 11 Dec'dd ]
8 Companert Bids Costs 2days 1 Dec 08 2 Dec'08 =
i 5 Rawed ek e o “Ton s TEeeT - |
Grab this
. . " Design Y alication 1 cay 1 Dec 06 1 D '8 - .
llne Wlth 12 Revised Bid Document fday  1Dects  1Dec'd @
. DmBOnET T Packages MNegoTate — Bdayrs 1 Dec 0 B 0§ 08 ]
the mousc 14 Bid Document Final 1day  1DecT8  1D4c'D8 @
. 15 Bicl Subimitted O days 1 Dec 06 1 D '8 Q 112 2
to split and a 2 s 2
resize the Mame: | Bid Request Diocuments Received Durstion: od B [IEFfort civen
Start: | 1Dec'ng v Finish: 1Dec'ng v Task type: Fized LUnits ~ %% Complete: e 4
screen 10 | Resource Mame Units Wark | A ID | Predecessor Mame Type Lag ~
Ready

A pane needs to be Active before menu items pertaining to that pane become available. A
dark blue band (with the standard Windows color scheme) on the left-hand side is displayed
in the Active Pane.

The menu options will often change when different Views are selected in a pane.

A Pane is made Active just by:

e (licking anywhere in the pane, or

e Pressing F6 to swap active panes.

Not all panes may be printed and only the Active Pane may be printed, thus
it is not possible to create a printout with a Gantt Chart and a Resource Sheet
(Table) or Graphs (Histograms) with Microsoft Project.
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Some Views displayed in Panes have further options for displaying data. These are titled
Details forms. The Details forms may be selected, when available, by:

e Making the pane active, then

e Selecting:

» Format, Details, or
» Right-clicking in the right-hand side of the screen and clicking the required form.

The example below is for the Task Information form:

Forrnak |

y Fonk...

Bar...
Timescale, ..

aridlines. ..

% ‘=antt Chart Wizard...

Texk Styles. ..

Bar Styles. ..

Dretails b ||+ Resources & Predecessors
Layoutk, .. Resources & Successors
Layouk Mow Predecessors & Successors
Drawing 9 Resource Scheduls

Resource Wark,
Resource Cost
MNotes

Chijects

4.5 Right-clicking with the Mouse

It is very important that you become used to using the right-click function of the mouse as
this is often a quicker way of operating the software than using the menus. The right-click
will normally display a menu, which is often different depending on the displayed View and
which pane is the Active Pane. It is advised that you experiment with each view to become
familiar with the menus.
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WORKSHOP 2

Setting Your Project Options

Background

For control purposes it is expected that all tasks will be entered in days.

Assignment

1. Select Tools, Options... and open the Project Options form. Click on each tab and
familiarize yourself with the forms. set your options as follows:

» Select View tab, set the Date format to:

1. “ddmmmyy” i.e., 28 Jan ’02, or

2. “mmmddyy” i.e., Jan 28 *02.

The available date format will depend on your system settings.
» Select the Schedule tab and set the Schedule Options as per the picture below:

Options
Wigw General
Interface Security
fschedulet l Calculation

Schedule options For Microsaft Office Project
Show scheduling messages

Show assignment units as a; | Percentage

Scheduling options for “Warkshop 1.mpp'

[Inew kasks are effort driven

[ autalink inserted or moved tasks

Split in-progress tasks

[JTasks will akways honar their constraink dates
Show that tasks have estimated durations
Mew kasks have eskimated durations

Mews tasks: Start On Project Stark Date
Duration is entered in: Days

work is entered in: Hours

Default bask bype: Fixed Units

X

l Calendar ]
l Save ]
w
w
w
w
w
k. ][ Cancel l

Continued over....
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2. Hide and display the Standard and Formatting toolbars using the View menu.

3. To ensure full menus are always displayed (and thus save time waiting for the menu
item you require to be displayed) check the Always show full menus option in the
under Tools, Customize, Toolbars..., Options tab.

4. Experiment by dragging the toolbars around the screen with your mouse.
5. Hide and display the View bar by selecting View, View Bar.

6. Split the screen into two panes by right-clicking with the mouse in the right-hand side of
the screen, and selecting Split from the menu.

7. Activate the lower pane by clicking in it; note the blue bar (or a different shade of bar if
you do not have the default Windows colors) on the left-hand side of the screen has
moved from the top pane to the bottom pane.

8. Activate the upper pane, by clicking in it.
9. Resize the panes by dragging the Split screen bar.
10. Close the Split screen by double-clicking on the horizontal dividing line.

11. Split the screen by double-clicking on the small bar in the bottom right-hand corner of
the screen.

12. Save your OzBuild Bid Project.
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7 ORGANIZING TASKS USING OUTLINING

Outlining is used to summarize and group tasks under a hierarchy of Parent or Summary
Tasks. They are used to present different views of your project during planning, scheduling
and statusing. These headings are normally based on your project breakdown structure. In a
PRINCE2 project these Summary Tasks may be used to represent the project Stages and/or
the Product Breakdown Structure.

Defining the project’s breakdown structure can be a major task for project managers. The
establishment of templates makes this operation simpler because a standard breakdown is
predefined and does not have to be typed in for each new project.

Projects should be broken into manageable areas by using a structure based on a breakdown
of the project deliverables, systematic functions, disciplines or areas of work. The Outline
structure created in your project should reflect the primary breakdown of your project,
normally as the PBS and Stages.

Microsoft Project 2000 introduced a new feature titled Grouping, which is similar to the
Organize function found in Primavera software. This feature allows the grouping of tasks
under headings other than the Outline Structure. Unlike Primavera software, Grouping is
not the primary method of organizing tasks. It is covered in the GROUPING, OUTLINE
CODES AND WBS chapter.

7.1  Creating an Outline
To create an Outline:

e Insert a new Summary task above the Detailed tasks:

&  |TaskMame Duration Start Finish 1 5ep & Sep
S|S M|T |W|T |F |S|S M|T |W|T |F
SUMMmary 1 day? 1 Sep 1 Sep -

Tazk 1 3days 1 Sep 35ep E
Taszk 2 2 days 4 Sep 5 5ep
Task 3 Jdavs g Sep 10 Sep .

e Then Demote the Detailed tasks below Summary task. (Demoting is explained in the
next section.):

4 | b —

o Task Mame Durstion Start Finizh 15ep 2 Sep
S[EM[TW[T[F[S[S[M][T [W][T[F
= Summary Sdays 1Sep 10 Sep ey

B o M =

Tazk 1 3days 1 Sep 3 Zep i
Taszk 2 2 days 4 Sep 5 Sep
Task 3 Jdays g Sep 10 Sep .

The Start and Finish dates of the Summary task are adopted from the earliest start date and
latest finish date of the Detailed tasks.

The duration of the Summary is calculated from the adopted start and finish dates over the
Summary task calendar, which is initially the Project Calendar.

The Duration and Finish dates of the Summary task are shaded because these were changed
after Tasks 1 to 3 were demoted. This shading may be removed by pressing F9 to
recalculate the schedule or saving the file.
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7.2 Promoting and Demoting Tasks

Demoting or Indenting tasks may be achieved in a number of ways. Select the task or tasks
you want to Demote. Ensure you have selected the whole task and not just some cells. You
may use any of the following methods to Demote a selected task:

Click on the Indent EI button, or
Right-click on the Task ID column to open the task shortcut menu, click on the
_ button, or

Move the mouse until you see a double-headed horizontal arrow in the task name, left-
click and drag the task right. A vertical line (see lower of the two pictures below) will
appear indicating the outline level you have dragged the task(s) to, or

€ |Task Name Duration 1 5ep 8 Sep
S|S M|T|W|T|F|S|S I‘I.I1|T|'I.-“-.I'|T|F
1 SuUmmaty 1 day? -
2 Tz | Gm— 3 days
3 Task 2 2 days E
4 Task 3 3 days :
8 |Task Name Duration 15ep B Sep
S|S M|T|W|T|F|S|S I‘I.I1|T|'I.-"-.I'|T|F
1 =] Summary 8 days e 4
2 Taszk 1 3 days
3 Task 2 2 days E
4 Task 3 3 days :

Hold down the Alt and Shift keys and press the Right Arrow Key on your keyboard.

Promoting or Outdenting tasks uses the same principle as demoting tasks. Select the task
or tasks you want to demote, ensure you have selected the whole task and not just some
cells, then you may:

Click on the Outdent El button, or

Right-click on the Task ID column to open the task shortcut menu, click on the

Move the mouse until you see a double-headed horizontal arrow in the task name
column, left-click and drag the tasks left, or

Hold down the Alt and Shift keys together and press the Left Arrow Key on your
keyboard.

Tasks may be added under a Detailed task and demoted to a third level and so on.

(5] Task Mame Duration 1 Sep 4 Sep
S|S M|T |W|T |F |S|S M|T |W|T |F

1 = Summary 8 days —
2 Task 1 3 days
3 Tazk 2 2days %\I\_
4 -l Task 3 3 days ;
5 Task 3.1 1 day E
o] Task 3.2 1 day %
7 Task 3.3 1 day
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7.3 Summary Task Duration Calculation

The Summary Task duration is calculated from the Start to the Finish over the calendar
assigned to the task, thus changing the summary task calendar will change the displayed
duration of the Summary Task:

Tazk Mame Duration Task Calendar 2 5 Mar 12 Mar
W T[F[S[sM[TMTIF[S[s[M][Tw[T][F

1 =l Summary 1 14 days T DayWeek L= =
2 Task Sdays 5 Dayhiieek
3 Tazk adays 5 Dayhiieek E%
4 = summary 2 f0days  5DayWeek ¥ v
5 Tazk I days 5 Dayiivieek : '
5] Tazk I days 3 Dayiivieek

7.4  Summarizing Tasks

Once you have created summary tasks, the detailed tasks may be rolled up or summarized
under the summary tasks. Rolled up tasks are symbolized by the + sign to the left of the
summarized task description:

e This picture shows Detailed Task 3 rolled up.

O  |TaskbName Durstion 1 Sep 3 Sep
SleM[Tw[T[F[S[s|M][T WwW[T][F
- Summar_l,r adﬂ}l‘S —

| oLy pa| =

Task 1 3 days i
Tazk 2 2days
+ Task 3 3 days

e This picture shows SUMMARY TASK rolled up.

o Task Mame Duration 15ep 3 Zep
S[EM[TW[TIF[s[s[M[Tw[T[F
1 T SLII'I'IITIBF_‘.F Bdﬂ]ﬁ —

7.4.1 To Roll Up Summary Tasks and Show Tasks

The Outline Symbols, [E] and [l in front of the tasks may be hidden and displayed from the
Tools, Options..., View tab, Show outline symbol.

Select the task you want to roll up:
e Click on the =] to the left of the Task Name, or

e (Click on the Hide Subtasks El icon, or
e Double-click on the Task ID (not the Task Name as this will open the Task form).

Displaying rolled-up tasks is similar to rolling them up. To do this, select the task you want
to expand. Then:

e Click on the [H to the left of the Task Name, or

e (Click on the Show Subtasks icon, or
e Double-click on the Task ID.
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7.4.2

Roll Up All Tasks to an Outline Level

A schedule may be rolled up to any Outline Level by selecting the desired Outline Level
from the drop-down box on the Formatting Toolbar.

W = 4 = T |ghewr | Arial -9 - B I U E = = alTasks - = |
Final Re 4& All Subtasks
o Task Mame Outline Level 1 Cec'08 8 Dec '08 15 Dec '08 22 Dec '08 28 Dec 'l
) TWTIFIS[S M TMTIFIS[SMTTIF|S|S MTWT|F[S)SM|[TMT|F

1 = OzBuild Bid Outling Level 2
2 -] Research Outline Lewvel 3
3 Bid R Outling Level 4 e E
4 Bid 5 Cutling Level 5 1
g Irves Cutling Level &
E d

% L] Outline Level 7 En
7 =| Estimatio
5 | Requ Outling Level & ?
9| Deve Outling Level 9 T
10 Draft Technical Details Schedule G
11 Compile Costs from Campanent Bi

7.4.3 Show All Tasks

4 . .
Select the | F Al Subtasks ‘ option at the top to display all tasks.

7.5  Project Summary Task

A Project Summary Task may be displayed by checking the Show project summary task
box from the Tools, Options..., View tab. This task spans from the first to the last task in
the project and is in effect a built-in Level 1 outline. The description of the Summary Task
is the Project Title entered in the File, Properties form. A Project Summary Task is a
virtual task and may not have resources, relationships or constraints assigned.

T (N O TS
_ﬁ_wm_\DlLDmﬂmmth—\D

o
&

i [2

Task Mame

=l Wilson International Bid

- Research

Bid Request Documents Recieved
Bid Strategy Meeting
Investinate Technical Feasibility

SRAUL 040712 0zBuild Workshop 9.mpp Properties

Dec '08 8 Dec'08 15 Dec 08 22 Dec 03
ThiTIF[S|S[MThTIFS[S M T TIF[S|S M| T TIF|
o

—I Estimation
Regquest General | SUmmary | Skatistics || Contents
Develop I I =
Title: Wilson Inkernational Bi
Draft Teg
Cornpile Subject: Bid
= Proposal Authaor: Paul E Hatris
Diraft Bid
Meeting Manager: Carol Peterson
Design A Company:  |Eastwood Harris

Cuskorn

@)X =l
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WORKSHOP 5

Entering Stages

Background
The summary tasks may be used to represent

The PRINCE2 Planning Process shows that you need to identify the following stages:
» Research
» Estimation
» Proposal

These will be added as Summary Tasks in this workshop.

Assignment

1. Go to the View tab in the Tools, Options... form and check the option to display the
Project Summary Task, close the form and observe how the Project Summary Task is
formatted

2. Remove the Project Summary Task as we will create an Outline Level for the Project
Summary Task.

(98]

Create an Outline Level 1 for the whole project entitled “OzBuild Bid” and

4. Create an Outline Level 2 for each of the three Stages: Research, Estimation and
Proposal. Try using the various methods for indenting and outdenting tasks.

5. Your schedule should look like this:

(i} Task Mame Druration Start Finish 1 Dec '08 8 Dec '08
S[SM[TW[T[F[S[S[M[TwW][T]F
1 = OzBuild Bid 9days 1Dec'08 11Dec’'08 ¥ =
2 ~I Research 8days 1Dec'08 10Dec’'08 ' =
3 Bid Reguest Documents Received Odays 1Dec'8 1Dec'08 ¢ 112
4 Bid Strategy 1day 1Dec'08 1Dec'08 ﬁ
a Technical Feasibility Study 8days 1Dec'D8 100Dec 08 =
G = Estimate 9days 1Dec'08 11Dec’'08 ' =
7 I% Installation Requirerments 4days 1Dec'D8 4Dec'08 =
g Supplier Component Bids 3days 1Dec'08 3Dec08 =
a % Fraject Schedula 4 days 1 Dec'08 4Dec'D8 S
10 Technical Specification 9days 1 Dec'0d 11 Dec'0d
11 Component Bids Costs 2days 1 Dec'D8 2Dec'08 ]
12 =l Proposal G6days 1Dec'08 8Dec'08 —W
13 Draft Bid Document Jdays 1 Dec'0d 3 Dec'0d =
14 Feviewwed Draft Bid Docurment 1day 1Dec'D8 1Dec'08 E
14 Cesign Yalidation 1day 1Dec'D8 1Dec'08 E
16 Fevised Bid Document 1day 1Dec'08 1Dec'08 ﬁ
17 Component Fackages MNegotiated Gdays 1Dec'03 gDec'0d
18 Bid Docurment Final 1day 1Dec'D8 1Dec'08 -
19 Bid Submitted Odays 1 Dec'D3 1Dec'0d & 112
6. Save your OzBuild Bid project.
Continued over...
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7. The second level of the Outline Structure could have been used for the Collective
Groupings Products and not Stages and would look like the example below:

(3] Task Narme Duration Start Finish 16 3 Dec '06 10 Dec '06
wWT[F[s[sM[TwW[T[F[s|5[mM[TW[T[F]5
1 =1 0zBuild Bid 9 days 4 Dec "06 14 Dec "06 W ¥
2 Bid Request Documents Received 0 days 4 Dec '06 4 Dec 06 & 412
3 =l Commercial 3 days 4 Dec "06 6 Dec "06
4 Bid Strategy 1 day 4 Dec '06 4 Dec '06
g Draft Bid Document 3 days 4 Dec '06 G Dec '06
3] Reviewed Draft Bid Document 1 day 4 Dec '06 4 Dec '06
T Revised Bid Document 1 day 4 Dec '06 4 Dec '06
8 Bid Document Final 1 day 4 Dec '06 4 Dec '06
9 Bid Submitted 0 days 4 Dec '06 4 Dec '06
10 =l Technical 9 days 4 Dec "06 14 Dec "06
11 Technical Feasihility Study 8 days 4 Dec '06 13 Dec 06
12 % Installation Requirements 4 days 4 Dec '06 7 Dec '06
13 Technical Details Schedule 9 days 4 Dec '06 14 Dec '06
14 Design Validation 1 day 4 Dec '06 4 Dec '06
15 = Planning and Estimating 6 days 4 Dec "06 11 Dec "06
16 % Froject Schedule 4 days 4 Dec '06 7 Dec '06
17 Component Bids 3 days 4 Dec '06 G Dec '06
18 Component Bids Costs 2 days 4 Dec '06 4 Dec '06
15 Compaonent'Woark Packages Megotiated B days 4 Dec '06 11 Dec '06

© Eastwood Harris Pty Ltd 7-6





